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Overview

This document provides an explanation of the steps required to perform a Bento(TM) to FileMaker®
Migration project using FmPro Migrator EE or FmPro Migrator Developer Edition.

Documentation Conventions:

FileMaker Pro/FileMaker Pro Advanced - refers to FileMaker Pro or FileMaker Pro Advanced version
8.5 or higher. In general, the term FileMaker Pro may refer to either FileMaker Pro or FileMaker Pro
Advanced, unless specifically noted otherwise.
Bento - refers to Bento database versions 1.x or 2.x

Document Version: 03
Date: 2/14/2009

 Feature Comparison

This table compares the features available with FmPro Migrator/FmPro Migrator Developer Edition
compared with the version of FileMaker Pro software installed. FileMaker Pro Advanced versions 8.0

FmPro Migrator - Bento to FileMaker Pro Migration Procedure - 4



and higher allow for copy/pasting of Table XML code via the clipboard. This method of creating tables
during the Bento to FileMaker Pro migration process is the recommended method. Pasting table XML
code via the clipboard retains the Auto Enter SN/Next Value field parameters gathered by FmPro
Migrator from the original Bento database backup file.
When using FileMaker Pro (instead of FileMaker Pro Advanced), each new table is created by using an
ODBC connection to the local FileMaker Pro database. The configuration of Auto Enter SN and Next
Value parameters must then be completed manually within the Define/Manage Database dialog.

FmPro Migrator Developer Edition includes the added features of automating the creation of
Relationships and Layouts within the new FileMaker Pro/FileMaker Pro Advanced database file. FmPro
Migrator Developer Edition utilizes QuicKeys(MacOSX)/WinAutomation(Windows) shortcuts to drive the
FileMaker user interface in order to automate the creation of Relationships and Layouts. FmPro
Migrator Developer Edition also includes a complete FileMaker Table Consolidation feature, which is
documented in detail within a separate PDF file.

 Migration Process Overview
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FmPro Migrator gathers schema info, relationships, data and forms directly from a Bento Backup
.bentodb file - on Mac OS X or Windows. Bento tables are created in FileMaker Pro by copying/pasting
the table definitions or via ODBC. Bento forms are instantly converted into Layouts which can be
pasted directly into FileMaker Pro/Advanced. Data from the original Bento database backup file is
transferred into FileMaker Pro via exporting/importing the data via a CSV/TAB delimited Unicode
(UTF8) file.
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Step 1 - Get Info - Bento

FmPro Migrator uses the information within the Bento Backup .bentodb folder to perform the conversion
of tables, data, relationships and forms from Bento to FileMaker Pro.  FmPro Migrator can be running
on MacOS X (10.3, 10.4, 10.5) or Windows in order to perform the conversion. It is not necessary to
have a copy of Bento running on the computer which is being used to perform the conversion.

 Step 1 - Create Bento Backup

The Bento backup will be given a default name having the format: Bento Backup MM/DD/YY.bentodb. 
This backup will only contain the data stored within the Bento database file. Address Book and iCal
data is not stored within the Bento SQLite database file, therefore this info will need to be exported
separately.

Cross-Platform Note: Since the default Bento backup folder name may contain  the"/" date separator
character, the Bento backup folder might not be read on Windows. Changing the date separator
character to any other character which is compatible with Windows, will resolve this problem. The
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Windows version of FmPro Migrator can be used to convert the Bento database in exactly the same
manner shown here on MacOS X.

 Step 1 - Click FileMaker Tab

Launch FmPro Migrator, then click on the FileMaker tab at the top of the window.
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 Step 1 - Get Info - Select Output Directory

FmPro Migrator stores migration process information within a SQLite database file named
MigrationProcess.db3. This file contains the metadata for the source Bento database backup file,
including tables, fields, table creation SQL code, forms and status info. Therefore the first step in the
migration process is to click the Browse button to select the output folder FmPro Migrator will use when
creating the MigrationProcess.db3 file. 

FmPro Migrator also creates a Themes folder within the output directory, which is used to convert the
Bento forms into FileMaker Pro layouts. These themes files can be modified to change how the new
FileMaker Pro layouts will be created.

(1) Select the output directory, then (2) select Bento from the Source Database menu.

(3) Either use the existing ODBC DSN name "example_fmp_dsn" or change this name to reflect the
name of a System ODBC DSN you will create on your computer.
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 Continue Migration...

Tip: To restart an existing migration project, select the output directory, then select Continue
Migration... from the File menu.
Click the yellow Continue button to open the Migration Process window.

 Step 1 - Get Info - Drag & Drop Bento Backup File

Drag & Drop the Bento Backup .bentodb file onto the Step 1 Get Info icon.
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 Step 1 - Get Info - Progress Dialog

FmPro Migrator will display progress dialog boxes as the file is being read and processed.
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 Step 1 - Get Info - Click Continue... Button

After the Converting Bento Forms... dialog disappears, click the yellow Continue... button.

 Step 1 - Time Saving Tip

If you are using FileMaker Pro Advanced, then you can create tables in FileMaker Pro by copying and
pasting the tables from FmPro Migrator to FileMaker Pro Advanced. You may skip the following step in
this documentation which describes how to install the FileMaker ODBC driver, since the data will be
imported via importing a CSV/TAB delimited file into the database. 

If you are using FileMaker Pro instead of FileMaker Pro Advanced, then you should install the
FileMaker ODBC driver in order to automate the creation of each of the tables/fields and field types
within the FileMaker Pro database. If you create the table by importing the CSV/TAB data file, the
FileMaker Pro database may not always be able to accurately determine the type of field to create for
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each imported field. FmPro Migrator uses the ODBC connection to create each field as the correct type
based upon the data stored within the original Bento database table. 
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Install FileMaker ODBC Driver - MacOS X

 Copy SequeLink.bundle File to /Library/ODBC

For FileMaker 7+ Databases on MacOS X:
Manually copy the SequeLink.bundle file from the ODBC Client Driver folder on the FileMaker
application CD or ESD dmg to the /Library/ODBC folder within MacOS X.

Note: Using the FileMaker ODBC driver with FileMaker Pro/Advanced 7+ requires the FileMaker
database file and ODBC driver to be open locally on the same computer where FmPro Migrator is
running. The exception to this requirement is when the database file is opened with FileMaker Server
Advanced. 

 Download & Install iODBC Driver Administrator from OpenLink Software

Download and install the iODBC Data Source Administrator, provided by OpenLinkSoftware, available
from (www.openlinksw.com). Downloading the iODBC framework or any trial version of an OpenLink
Software ODBC driver for MacOS X will provide you with the iODBC Driver Manager. The iODBC driver
manager does not stop working after the trial software expires. The iODBC driver manager provides a
test feature which enables you to quickly test ODBC driver connections after creating or updating an
ODBC DSN.
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 Add the Driver

Open the OpenLink ODBC Administrator application, (1) click on the ODBC Drivers tab, then (2) click
the Add a driver button.
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 Specify Name and Pathname to Driver

(1) Enter a descriptive name for the driver, this is a name which you will select when creating an ODBC
DSN which uses the driver. (2) Enter the full pathname to the ivslk component within the
SequeLink.bundle file.
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This image shows part of the pathname to use for a FileMaker 9 ODBC driver, with the full pathname
listed below:

/Library/ODBC/sequelink.bundle/contents/macos/ivslk20.dylib

The name of the ivslk component changes with each revision of the DataDirect SequeLink driver file.
You can't count on it staying the same, so it is recommended that you navigate to the location of the
SequeLink.bundle file and select Ctrl + Show Package Contents to view the contents of the MacOS
folder.  Clicking the Browse button to the right of the Driver file name field doesn't allow the selection of
individual components within bundle files. You always need to manually type in this pathname.

(3) Click the Ok button, and the driver will be added to the list of available ODBC Drivers.

If the driver doesn't get added, try to close, then reopen the ODBC Administrator program.
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 Add a System DSN

(1) Click the System DSN tab, then (2) click the Add button.
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 Choose FileMaker ODBC Driver

(1) Select the FileMaker 9 ODBC driver from the list, (2) click the Finish button.
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 Enter System DSN Parameters

(1) Enter the name of the DSN, this name must match the name shown within FmPro Migrator for the
FileMaker Pro database. (2) Enter the Port, (3) Host, (4) ServerDataSource and (5) ServerDataName.
Each Keyword and Value needs entered manually in the Keyword and Value fields. (6) After entering
each Keyword/Value pair, click the Add button and the values will appear in the list of Keyword/Value
pairs.

(7) Click the Ok button to create the System DSN.
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Note: Setting up the ServerDataSource and ServerDataName values with "Default" values, enables
multiple individual FileMaker Pro files to be used with the driver, without requiring a change to be made
to the ODBC DSN parameters. However the limitation associated with this configuration is that only one
FileMaker Pro database file can be used at one time with the ODBC driver. Having two database files
open at the same time confuses the ODBC driver (even if a tablename is specified to the driver)
causing none of the tables within any of the open files to be found by the ODBC driver.

 Enable ODBC/JDBC Sharing within FileMaker Pro

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going to be
used with the FileMaker ODBC driver.
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 Select Sharing Parameters

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All
Users, then (4) click the Ok button.
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 Test ODBC DSN

(1) Click the System DSN which has just been created, (2) click the Test button.
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Enter the (1) Username, (2) Password, then (3) click the Ok button to test the ODBC DSN.

If the test passes, this dialog will be displayed, showing that the ODBC Driver Manger has used this
ODBC DSN to successfully connect to the FileMaker database.

If the test fails:
1) Re-verify the pathname to the svlk file within the SequeLink.bundle file.
2) Verify that the FileMaker database file is open.
3) Verify that ODBC sharing is enabled for the account entered in the connection test dialog prompt.
4) Make sure that there aren't two different copies of FileMaker running at the same time. Both older
and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type of conflict
occurs, close both versions of the FileMaker application, and only open the one copy you want to serve
the database file being migrated.
5) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). Then
test the DSN again after rebooting.
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Install FileMaker ODBC Driver - Windows

 Install FileMaker ODBC Driver

Run the DataDirect SequeLink installer, within the xDBC/ODBC Client Driver Installer folder on the
FileMaker Pro installation CD. Follow the prompts to install the FlleMaker ODBC Driver. 
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 Create ODBC DSN

To create a new System ODBC DSN, open the Control Panel > Administrative Tools > Data Sources
(ODBC) Control Panel.
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(1) Click the System DSN tab, then (2) click the Add button.
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(1) Select the DataDirect 32-BIT SequeLink driver, then (2) click the Finish button.

If the DataDirect 32-BIT SequeLink driver does not appear within the list of available drivers, please
refer to FileMaker Technical Support Knowledge Base record #357 for more details about the driver
installation process.
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(1) Enter the Data Source Name, (2) SequeLink Server Host, (3) SequeLink Server Port, then (4) click
on the Server Data Source button.
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 Set Data Source = Default

(1) Click the item named "Default", then (2) click the Ok button. Don't select the actual name of the
database shown in the list, or you will have to change the database name for each individual database
file which you want to use with this ODBC DSN. Selecting the Default item in the list insures that you
will always be able to open any FileMaker database file regardless of its name, as long as ODBC
sharing is enabled.

Note: Setting up the Server Data Source value to the "Default" value, enables multiple individual
FileMaker Pro files to be used with the driver, without requiring a change to be made to the ODBC DSN
parameters. However the limitation associated with this configuration is that only one FileMaker Pro
database file can be used at one time with the ODBC driver. Having two database files open at the
same time confuses the ODBC driver (even if a tablename is specified to the driver) causing none of
the tables within any of the open files to be found by the ODBC driver.
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 Enable ODBC/JDBC Sharing within FileMaker Pro

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going to be
used with the FileMaker ODBC driver.
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 Select Sharing Parameters

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All
Users, then (4) click the Ok button.
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 Test ODBC DSN

Click the Test Connect button, enter the Username/Password to connect to the FileMaker database file
which is currently open. 

If the test fails:
1) Verify that the FileMaker database file is open.
2) Verify that ODBC sharing is enabled for the account entered into the connection test dialog prompt.
3) Make sure that there aren't two different copies of FileMaker running at the same time. Both older
and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type of conflict
occurs, close both versions of the FileMaker application, and only open the one copy you want to serve
the database file being migrated.
4) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). Then
test the DSN again after rebooting.
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Click the Ok button to save changes and create the new System DSN.
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Step 2 - Create Tables

 Step 2 - Create Tables via ClipBoard - Auto Enter SN Fields

FmPro Migrator automatically determines the name and attributes for the Primary Key column within
each Bento database table. Bento Primary Key fields are converted into numeric Auto Enter Serial
Number fields within FileMaker Pro, having the Next Value, Unique and Not Empty field validation
parameters enabled. 
Bento Counter fields are also configured as Auto Enter Serial Number fields having the Next Value
parameter configured, but since Counter fields are not Primary Key fields, the Unique and Not Empty
validation parameters are not automatically enabled.

Pasting the Table XML code into FileMaker Pro Advanced has the advantage of automatically
configuring each Primary Key or Bento Counter field as an Auto Enter Serial Number field, with the
correct Next Value set for the field. If the table is created via ODBC, then these field attributes must be
set manually.
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 Step 2 - Create Tables via ClipBoard - Using FileMaker Pro Advanced

If FileMaker Pro Advanced is being used, it is faster to create the tables by pasting the Table XML code
via the ClipBoard. 
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This process creates all of the tables at once, without requiring each table to be clicked in the list of
tables. Since the Auto Enter Serial Number fields are configured automatically, this is an additional
time-saving reason for creating the tables by pasting the table XML code via the ClipBoard.

Click the Copy All Tables to ClipBoard button on the Tables Tab of the Migration Process window.

 Step 2 - Create Tables via ClipBoard - Define/Manage Database... Menu

While gathering info from the Bento backup file, FmPro Migrator created and opened a new empty
FileMaker Pro database file named FileMakerDB.fp7 within the output directory.

Select Define/Manage Database... from the File menu within FileMaker Pro Advanced.
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 Step 2 - Create Tables via ClipBoard - Paste Tables

(1) Click the Tables tab (if necessary), (2) then click on the Paste button.

Note: If the Paste button is grayed out, this means that the table XML code didn't get copied to the
ClipBoard before the Define/Manage Database dialog was opened. If this happens, click the Copy All
Tables to ClipBoard button again from within FmPro Migrator. Switching from the Fields tab and then
switching back to the Tables tab will cause FileMaker Pro Advanced to check the ClipBoard again for
Table XML info. When the Table XML code is found on the ClipBoard, the Paste button will be enabled.
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 Step 2 - Create Tables via ClipBoard - Paste Tables Result

The new tables will be created and then displayed within the Tables list.
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 Step 2 - Create Tables via ClipBoard - Auto-Enter Serial Number Attributes

You can verify that the Primary Key gnpk field has been automatically created as an Auto Enter Serial
Number field having the Next Value parameter matching the value shown in the FmPro Migrator field
details list.
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 Step 2 - Create Tables via ClipBoard - Validation Attributes

Since the gnpk field is a Primary Key, the Not Empty and Unique Value Validation parameters are also
checked automatically.

FmPro Migrator - Bento to FileMaker Pro Migration Procedure - 41



 Step 2 - Create Tables via ODBC - Using FileMaker Pro

FileMaker Pro (instead of FileMaker Pro Advanced) does not have the capability of accepting Table
XML code pasted into the Define/Manage Database Tables window. But FileMaker Pro does allow
creating tables via an ODBC connection. 
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Using the previously created ODBC DSN, click on each table within the FmPro Migrator Tables list,
then click the Create Table button.

Note:  If you previously created tables by pasting Table XML code via the ClipBoard, the status of the
Step 2 button will be "Completed", meaning that you can skip this step and proceed to Step 3 Transfer
Data.

 

 Step 2 - Create Tables via ODBC - Troubleshooting - Data Source Name Not Found

Troubleshooting: If an error occurs while attempting to create the new table in FileMaker Pro, check
the following items:

Data Source Name Not Found - This error means that the ODBC DSN entered into FmPro Migrator
for the FileMaker Pro Destination Database, has not been created. You may use any name you desire
for the ODBC DSN, but the name of the DSN you create within the ODBC Administrator needs to
match the name listed in FmPro Migrator.
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 Step 2 - Create Tables via ODBC - Troubleshooting - Duplicate Name

Duplicate Name - This error means that the table has already been created within the FileMaker Pro
database. Hold down the Shift key when clicking the Create Table button to delete and re-create the
table.
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Step 3 - Transfer Data

 Step 3 - Transfer Data
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(1) Click on a table in the list of tables, (2) select the export file type CSV/TAB (if necessary), then click
the Step 3 Transfer Data button. FmPro Migrator will export all of the Bento tables as individual files
into the output directory. Once the data has been transferred successfully, the status menu below the
Step 3 Transfer Data button will change from "Not Started" to "Completed".

Note: Both Tab delimited and Comma Separated export file formats are supported by FmPro Migrator.
The CSV file format is the default export format, as this format preserves return characters embedded
within any of the fields. The TAB file format is supported in order to enable the export of data to other
programs which might not support the CSV file format. 

 Step 3 - Transfer Data - Import CSV File

Within FileMaker Pro, select the layout for the the first table of data you want to import.
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 Step 3 - Transfer Data - Select Import Records

Select Import Records -> File... from the File menu.
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 Step 3 - Transfer Data - Select File

(1) Select the CSV file for the Bento table, (2) click the Open button.
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 Step 3 - Transfer Data - Import Field Mapping Dialog

(1) Select Unicode (UTF-8) from the Character Set menu, (2) check the "Don't Import first record"
checkbox, (3) click the Import button. Since FmPro Migrator has written the field names into the first line
of the CSV/TAB file, FileMaker Pro will automatically match up the data columns with the correct fields
in the new FileMaker Pro database table.

Note: It is important to always select Unicode (UTF-8) as the Character Set, because this is the format
FmPro Migrator uses to export records from the Bento tables. The UTF-8 encoding supports single and
double-characters worldwide. 
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If you forget to select the "Don't Import first record" checkbox, an extra record will be written into the
table containing the fieldnames, this extra record can be deleted manually if necessary.
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Step 4 - Create Relationships - FmPro Migrator Developer Edition - MacOS X

FmPro Migrator Developer Edition uses QuicKeys to automate the creation of Relationships and
Layouts within the FileMaker Pro database.

 Step 4 - Create Relationships - MacOS X
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Click the Relationships tab.

Click the Create All Relationships in FileMaker button.

 Step 4 - Click Download QuicKeys Button (Mac OS X) - [1st Time Setup Step]

The Download QuicKeys dialog is displayed by FmPro Migrator on Mac OS X. Click the Download
QuicKeys button if you don't already have QuicKeys 3.03 (or higher) installed on Mac OS X. 

Click this download button even if you do have QuicKeys installed, because clicking this button triggers
FmPro Migrator to create the FmPro Migrator QuicKeys Installation.pdf and FmPro Migrator QuicKeys
Shortcuts - Mac.qkexport files within the output directory. Whenever the QuicKeys Shortcuts have been
updated within FmPro Migrator, you will need to click on the Downloads QuicKeys button in order to
extract the latest shortcuts from FmPro Migrator for installation on your computer.

Follow the instructions within the FmPro Migrator QuicKeys Installation.pdf file to import the QuicKeys
shortcuts from the FmPro Migrator QuicKeys Shortcuts - Mac.qkexport file into QuicKeys and set up the
QuicKeys variables. These QuicKeys shortcuts use 10 QuicKeys variables which must be created
manually prior to using the shortcuts. 
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 Step 4 - Click Ok Button (Mac OS X)

After QuicKeys and the QuicKeys shortcuts are installed, click the Create All Relationships in FileMaker
button a 2nd time, then click the Ok button.

 Step 4 - Create Relationships - Controlling Automated Relationship Creation

The Relationships window will be opened within FileMaker, and each of the Relationships will be
created.

It is not generally necessary for you to click any of the buttons in the status area. These buttons
perform the following tasks:

Next Relationship - This button gets clicked by the QuicKeys shortcut after it creates each Relationship,
in order to start the process of creating the next Relationship.

Current Relationship - If the QuicKeys shortcut gets stuck in some way and fails to create a
Relationship, you can click on this button to attempt re-creating the Relationship currently being
processed.
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Done - Click this button if you want to cancel the Relationship creation process.

 Step 4 - Create Relationships - Click OK buttons

At the end of the Create Relationships process, QuicKeys will leave the Edit Relationship and
Relationship Graph windows open. Click the OK button for both of these windows.
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Step 4 - Create Relationships - FmPro Migrator Developer Edition - Windows

FmPro Migrator Developer Edition uses WinAutomation to automate the creation of Relationships and
Layouts within the FileMaker Pro database.

 Step 4 - Create Relationships - Windows

FmPro Migrator - Bento to FileMaker Pro Migration Procedure - 55



Click the Relationships tab.

Click the Create All Relationships in FileMaker button.

 Step 4 - Create Relationships - Click Download WinAutomation Button (Windows) - [1st
Time Setup Step]

The Download WinAutomation dialog is displayed by FmPro Migrator on Windows. Click the Download
WinAutomation button if you don't already have WinAutomation 1.2.0.622 (or higher) installed on
Windows. 

Click this download button even if you do have WinAutomation installed, because clicking this button
triggers FmPro Migrator to create the FmPro Migrator WinAutomation Installation.pdf and FmPro
Migrator WinAutomation Jobs.zip files within the output directory. Whenever the WinAutomation Jobs
have been updated within FmPro Migrator, you will need to click on this button in order to extract the
latest versions of these jobs from FmPro Migrator for installation on your computer.

Follow the instructions within the FmPro Migrator WinAutomation Installation.pdf file to import the
WinAutomation jobs from the FmPro Migrator WinAutomation Installation Jobs.zip file into
WinAutomation.
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 Step 4 - Create Relationships - Start WinAutomation Console (Windows) - [1st Time
Setup Step]

The WinAutomation Console application will install and startup the WinAutomation Service the first time
it is launched. You may close the WinAutomation Console after importing the WinAutomation jobs.
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 Step 4 - Click the Create All Relationships in FileMaker Button (2nd Time)

FmPro Migrator will then use the WinAutomation shortcuts to drive the FileMaker user interface in the
same manner as a user would manually create each of the Relationships in FileMaker Pro.
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 Step 4 - Create Relationships - Get TOs List

FmPro Migrator needs to gather a list of Table Occurrences from the destination database sorted in
alphabetical order using FileMaker's sorting algorithm. This list of TOs will be used when selecting TOs
from menus when creating each Relationship.

Switch to the FileMaker database, don't click on the Ok button yet.

Switch to the previously opened FileMakerDB.fp7 file, click the Get TOs List button.

 Step 4 - Create Relationships - Get TOs List
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Click the Get TOs List button on the Get TOs List layout in the destination database. The TOs list is
now on the ClipBoard. Click the Ok button displayed by FileMaker Pro.

 Step 4 - Create Relationships - Get TOs List

Now that the alphabetical list of TOs are on the ClipBoard, click the Ok button so that FmPro Migrator
can retrieve them from the ClipBoard.

 Step 4 - Create Relationships - Controlling Automated Relationship Creation

The Relationships window will be opened within FileMaker, and each of the Relationships will be
created.

It is not generally necessary for you to click any of the buttons in the status area. These buttons
perform the following tasks:

Next Relationship - This button gets clicked by the WinAutomation job after it creates each
Relationship, in order to start the process of creating the next Relationship.

Current Relationship - If the WinAutomation job gets stuck in some way and fails to create a
Relationship, you can click on this button to attempt re-creating the Relationship currently being
processed.
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Done - Click this button if you want to cancel the Relationship creation process.
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 Step 4 - Create Relationships - Click OK buttons
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At the end of the Create Relationships process, the WinAutomation job will leave the Edit Relationship
and Relationship Graph windows open. Click the OK button for both of these windows.
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Step 4 - Create Relationships - Manual Process

Relationships can be created manually in the FileMaker Pro database if you don't have FmPro Migrator
Developer Edition or if you have a small number of relationships which might not justify buying the
QuicKeys or WinAutomation software. If you have fewer than 20 relationships, you may want to create
the relationships manually, as the process doesn't take very long for small numbers of relationships.

 Step 4 - Create Relationships - Click Relationships Tab
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Click the Relationships tab in the Migration Process window.

 Step 4 - Create Relationships - View Relationship Details
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(1) Click each relationship in the list to view the relationship details (2)(3).

 Step 4 - Create Relationships - Define/Manage Database... Menu

Select Define/Manage Database... from the File menu within FileMaker Pro.
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 Step 4 - Create Relationships - Click Relationships Tab

Click the Relationships tab within the Define/Manage Database window.
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 Step 4 - Create Relationships - Click Edit Relationship Button

Click the Edit Relationship button.

FmPro Migrator - Bento to FileMaker Pro Migration Procedure - 68



 Step 4 - Create Relationships - Add Relationship Predicate Button

Select the table and fields to match the values displayed for the relationship within FmPro Migrator.
Click the appropriate check boxes for Creation/Deletion of records via the relationship.
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 Step 4 - Create Relationships - Add Relationship Predicate Button

Click the Ok button.

Repeat this process for each relationship listed in the Relationships List within FmPro Migrator.
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Note: If you Drag & Drop the Bento Backup file more than once, the relationships and Layouts will be
duplicated each time FmPro Migrator reads the backup file. Duplicates may be removed individually by
clicking the Delete Selected Relationships button within FmPro Migrator.
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Step 5 - Create Layouts - FmPro Migrator Developer Edition - MacOS X

FmPro Migrator Developer Edition uses QuicKeys to automate the creation of Layouts within the
FileMaker Pro database. 

 Step 5 - Create Layouts - Click Layouts Tab
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The Bento forms were converted into FileMaker Pro Layouts when FmPro Migrator read the Bento
Backup file. These new Layouts are listed in the Layouts tab of the Migration Process window.

Click the Layouts tab, to create all of the layouts in the destination FileMaker database file.
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 Step 5 - Create Layouts - Pass#1

Click the Create All Layouts in FileMaker button. The Pass#1 pop-up menu should be selected under
the Create All Layouts in FileMaker button. The Pass#2 option won't be used when creating the Bento
converted Layouts in FileMaker Pro.
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 Step 5 - Create Layouts - [Mac OS X Dialog]

Click the Ok button on the Create Layouts dialog, since QuicKeys and the required shortcuts have
already been installed.

 Step 5 - Create Layouts - [ Mac OS X Status Area]

The database window will switch to Layout mode within FileMaker Pro, and each of the Layouts will be
created from the information stored within FmPro Migrator.

It is not generally necessary for you to click any of the buttons in the status area. These buttons
perform the following tasks:

Next Layout - This button gets clicked by the QuicKeys shortcut after it creates each Layout, in order to
start the process of creating the next Layout.

Current Layout - If the QuicKeys shortcut gets stuck in some way and fails to create a Layout, you can
click on this button to attempt re-creating the Layout currently being processed.
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Done - Click this button if you want to cancel the Layout creation process.
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Step 5 - Create Layouts - FmPro Migrator Developer Edition - Windows

FmPro Migrator Developer Edition uses WinAutomation to automate the creation of Layouts within the
FileMaker Pro database. 

 Step 5 - Create Layouts - Click Layouts Tab
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The Bento forms were converted into FileMaker Pro Layouts when FmPro Migrator read the Bento
Backup file. These new Layouts are listed in the Layouts tab of the Migration Process window.

Click the Layouts tab, to create all of the layouts in the destination FileMaker database file.
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 Step 5 - Create Layouts - Pass#1

Click the Create All Layouts in FileMaker button. The Pass#1 pop-up menu should be selected under
the Create All Layouts in FileMaker button. The Pass#2 option won't be used when creating the Bento
converted Layouts in FileMaker Pro.
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 Step 5 - Create Layouts - [Windows Dialog]

Click the Ok button on the Create Layouts dialog, since WinAutomation and the required jobs have
already been installed.

 Step 5 - Create Layouts - [Windows Dialog #2]

FmPro Migrator needs to gather a list of Table Occurrences from the destination database sorted in
alphabetical order using FileMaker's sorting algorithm. This list of TOs will be used when selecting TOs
from menus when creating each Layout.

Switch to the FileMaker database, don't click on the Ok button yet.
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 Step 5 - Create Layouts - Get TOs List [Windows]

Click the Get TOs List button on the Get TOs List layout in the destination database.
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 Step 5 - Create Layouts - [Windows Dialog #3]

Once the TOs list has been gathered from the destination database, click the Ok button displayed by
FileMaker.

 Step 5 - Create Layouts - [Windows Dialog #2]

Now that the alphabetical list of TOs are on the ClipBoard, switch back to FmPro Migrator Developer
Edition and click the Ok button so that FmPro Migrator Developer Edition can retrieve them from the
ClipBoard.

Once FmPro Migrator Developer Edition has retrieved the list of TOs from the ClipBoard, it will start
creating the Layouts within the destination FileMaker database.
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 Step 5 - Create Layouts - [Windows Status Area]

The data window will be opened in Layout mode within FileMaker, and each of the Layouts will be
created from the information stored within FmPro Migrator.

It is not generally necessary for you to click any of the buttons in the status area. These buttons
perform the following tasks:

Next Layout - This button gets clicked by the WinAutomation job after it creates each Layout, in order to
start the process of creating the next Layout.

Current Layout - If the WinAutomation job gets stuck in some way and fails to create a Layout, you can
click on this button to attempt re-creating the Layout currently being processed.

Done - Click this button if you want to cancel the Layout creation process.
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Step 5 - Create Layouts - Manual Process

Layouts can be created manually in the FileMaker Pro database if you don't have FmPro Migrator
Developer Edition or if you have a small number of Layouts which might not justify buying the QuicKeys
or WinAutomation software. If you have fewer than 20 Layouts, you may want to create the Layouts
manually, as the process doesn't take very long for small numbers of Layouts.

 Step 5 - Create Layouts - Click Layouts Tab
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The Bento forms were converted into FileMaker Pro Layouts when FmPro Migrator read the Bento
Backup file. These new Layouts are listed in the Layouts tab of the Migration Process window.

Click the Layouts tab, to create each of the Layouts individually in the destination FileMaker database
file.
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 Step 5 - Create Layouts - Click Copy Selected Layout to ClipBoard Button

Click the first Layout in the list, then click the Copy Selected Layout to ClipBoard button. The Layout
info will be put onto the ClipBoard.
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Note: The (1) Table/Table Occurrence name and (2) Layout name listed on this window will be used to
create each Layout within the FileMaker Pro database.

 Step 5 - Create Layouts - Switch to Layout Mode

Switch to FileMaker Pro, then switch to Layout mode.
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 Step 5 - Create Layouts - New Layout

Select New Layout from the Layouts menu.
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 Step 5 - Create Layouts - New Layout

(1) Select the Table Occurrence from the list, (2) Enter the Layout Name, (3) Select Blank Layout, (4)
Click the Finish button.

The Table Occurrence name and Layout name info needed to fill in these fields/menus is shown on the
FmPro Migrator Layouts tab when each layout is selected.
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 Step 5 - Create Layouts - Blank Layout

It is easier to manage the Layout parts if you delete the Header and Footer parts before pasting the
Layout objects onto the blank Layout. Click the Layout part, then press the Delete key to delete it.
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 Step 5 - Create Layouts - Paste Layout

Select Paste from the Edit menu, or select Control - V (Windows) or Command - V (MacOS X). Click
Yes to the "increase the size of the layout" dialog.
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 Step 5 - Create Layouts - Pasted Layout

The Layout objects will be pasted into the empty layout.

Repeat this process for each of the Layouts which were created from the Bento Backup file.
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Manual Completion Tasks

There are some processing steps which must be completed manually when performing a Bento to
FileMaker conversion.

 Manual Tasks - Object Size and Position

FmPro Migrator creates new Layouts from Bento 1.x forms by putting the field labels to the left of each
Layout field. However some Bento forms are designed with labels above the fields. Since the spacing
around the objects is slightly different when labels are on the left versus above each field, some manual
fine-tuning of object positions may be required on the new FileMaker Pro Layout.

Bento 2.x schema enhancements have made it possible for FmPro Migrator to convert Bento forms
with greater precision than was previously implemented for Bento 1.x files. Bento 2.x forms having
labels at the top and side are now supported along with the 10 new Bento 2.x built-in themes. Bento 1.x
users may upgrade their files for free by downloading the Bento 2 Trial Edition software, in order to take
advantage of the enhanced FmPro Migrator migration features.

 Manual Tasks - Address Book & iCal Data

Neither Address Book or iCal records are stored within the Bento Backup file. This data can be
manually exported from the Address Book and iCal and then imported into newly created tables within
the FileMaker Pro database file. It will also be necessary to manually create relationships between each
of the library tables and the Address Book and iCal tables.

 Manual Tasks - Media & File Fields

According to the Bento Backup dialog, Bento Media objects are not stored within the Bento database
file. But the path to these files is stored within the File_URL field in the new FileMaker Pro database
table, once the data has been transferred from Bento to FileMaker Pro. To provide similar functionality
within FileMaker Pro, a container field could be created to display the contents of the File_URL field. 

Then a Set Field ScriptMaker step can be run on each record to set the container field to reference a
new file path to reference the data. A new file path needs to be specified for each media file because
FileMaker Pro cannot read the original file path within the /Users/username/Library/Application
Support/Bento/bento.bentodb bundle file. These files should be manually moved to a new folder before
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they are used from within FileMaker Pro. The new pathname should be substituted for the original
pathname, either thru the use of a ScriptMaker script, calculation formula or thru manually referencing
the file by right-clicking on the container field to specify the new path to the file.  When selecting the file
manually, you can specify that only a reference to the file should be stored (recommended) or the entire
file can be stored within the container field (not usually recommended).

 Manual Tasks - Lock Background Graphics

Each Layout includes a PNG image which serves as the background image. There are also PNG
images used to create shaded areas around fields selected for shading in the original Bento form. It is
easier to select and move FileMaker Pro fields sitting on top of these background images if the
background images have been locked on the Layout. In Layout mode, select the background image,
then select Lock from the Arrange menu.

FmPro Migrator - Bento to FileMaker Pro Migration Procedure - 94


	FmPro Migrator - Bento to FileMaker Pro Migration Procedure
	Table of Contents
	1  
	1.1  Overview
	Feature Comparison
	Migration Process Overview

	1.2  Step 1 - Get Info - Bento
	Step 1 - Create Bento Backup
	Step 1 - Click FileMaker Tab
	Step 1 - Get Info - Select Output Directory
	Continue Migration...
	Step 1 - Get Info - Drag & Drop Bento Backup File
	Step 1 - Get Info - Progress Dialog
	Step 1 - Get Info - Click Continue... Button
	Step 1 - Time Saving Tip

	1.3  Install FileMaker ODBC Driver - MacOS X
	Copy SequeLink.bundle File to /Library/ODBC
	Download & Install iODBC Driver Administrator from OpenLink Software
	Add the Driver
	Specify Name and Pathname to Driver
	Add a System DSN
	Choose FileMaker ODBC Driver
	Enter System DSN Parameters
	Enable ODBC/JDBC Sharing within FileMaker Pro
	Select Sharing Parameters
	Test ODBC DSN

	1.4  Install FileMaker ODBC Driver - Windows
	Install FileMaker ODBC Driver
	Create ODBC DSN
	Set Data Source = Default
	Enable ODBC/JDBC Sharing within FileMaker Pro
	Select Sharing Parameters
	Test ODBC DSN

	1.5  Step 2 - Create Tables
	Step 2 - Create Tables via ClipBoard - Auto Enter SN Fields
	Step 2 - Create Tables via ClipBoard - Using FileMaker Pro Advanced
	Step 2 - Create Tables via ClipBoard - Define/Manage Database... Menu
	Step 2 - Create Tables via ClipBoard - Paste Tables
	Step 2 - Create Tables via ClipBoard - Paste Tables Result
	Step 2 - Create Tables via ClipBoard - Auto-Enter Serial Number Attributes
	Step 2 - Create Tables via ClipBoard - Validation Attributes
	Step 2 - Create Tables via ODBC - Using FileMaker Pro
	Step 2 - Create Tables via ODBC - Troubleshooting - Data Source Name Not Found
	Step 2 - Create Tables via ODBC - Troubleshooting - Duplicate Name

	1.6  Step 3 - Transfer Data
	Step 3 - Transfer Data
	Step 3 - Transfer Data - Import CSV File
	Step 3 - Transfer Data - Select Import Records
	Step 3 - Transfer Data - Select File
	Step 3 - Transfer Data - Import Field Mapping Dialog

	1.7  Step 4 - Create Relationships - FmPro Migrator Developer Edition - MacOS X
	Step 4 - Create Relationships - MacOS X
	Step 4 - Click Download QuicKeys Button (Mac OS X) - [1st Time Setup Step]
	Step 4 - Click Ok Button (Mac OS X)
	Step 4 - Create Relationships - Controlling Automated Relationship Creation
	Step 4 - Create Relationships - Click OK buttons

	1.8  Step 4 - Create Relationships - FmPro Migrator Developer Edition - Windows
	Step 4 - Create Relationships - Windows
	Step 4 - Create Relationships - Click Download WinAutomation Button (Windows) - [1st Time Setup Step]
	Step 4 - Create Relationships - Start WinAutomation Console (Windows) - [1st Time Setup Step]
	Step 4 - Click the Create All Relationships in FileMaker Button (2nd Time)
	Step 4 - Create Relationships - Get TOs List
	Step 4 - Create Relationships - Get TOs List
	Step 4 - Create Relationships - Get TOs List
	Step 4 - Create Relationships - Controlling Automated Relationship Creation
	Step 4 - Create Relationships - Click OK buttons

	1.9  Step 4 - Create Relationships - Manual Process
	Step 4 - Create Relationships - Click Relationships Tab
	Step 4 - Create Relationships - View Relationship Details
	Step 4 - Create Relationships - Define/Manage Database... Menu
	Step 4 - Create Relationships - Click Relationships Tab
	Step 4 - Create Relationships - Click Edit Relationship Button
	Step 4 - Create Relationships - Add Relationship Predicate Button
	Step 4 - Create Relationships - Add Relationship Predicate Button

	1.10  Step 5 - Create Layouts - FmPro Migrator Developer Edition - MacOS X
	Step 5 - Create Layouts - Click Layouts Tab
	Step 5 - Create Layouts - Pass#1
	Step 5 - Create Layouts - [Mac OS X Dialog]
	Step 5 - Create Layouts - [ Mac OS X Status Area]

	1.11  Step 5 - Create Layouts - FmPro Migrator Developer Edition - Windows
	Step 5 - Create Layouts - Click Layouts Tab
	Step 5 - Create Layouts - Pass#1
	Step 5 - Create Layouts - [Windows Dialog]
	Step 5 - Create Layouts - [Windows Dialog #2]
	Step 5 - Create Layouts - Get TOs List [Windows]
	Step 5 - Create Layouts - [Windows Dialog #3]
	Step 5 - Create Layouts - [Windows Dialog #2]
	Step 5 - Create Layouts - [Windows Status Area]

	1.12  Step 5 - Create Layouts - Manual Process
	Step 5 - Create Layouts - Click Layouts Tab
	Step 5 - Create Layouts - Click Copy Selected Layout to ClipBoard Button
	Step 5 - Create Layouts - Switch to Layout Mode
	Step 5 - Create Layouts - New Layout
	Step 5 - Create Layouts - New Layout
	Step 5 - Create Layouts - Blank Layout
	Step 5 - Create Layouts - Paste Layout
	Step 5 - Create Layouts - Pasted Layout

	1.13  Manual Completion Tasks
	Manual Tasks - Object Size and Position
	Manual Tasks - Address Book & iCal Data
	Manual Tasks - Media & File Fields
	Manual Tasks - Lock Background Graphics



